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1. Lwu y quan trong

Sé tay st dung dién t& nay danh cho moi
ngwdi dung st dung man hinh Philips.
Hay danh thai gian doc sb tay st dung
nay trwéde khi st dung man hinh. Sé tay
bao gdm nhirng théng tin va cac lwu y
quan trong lién quan dén viéc s dung
man hinh.

Ché dd bao hanh cla Philips ap dung v&i
diéu kién la san pham phai dwgc st dung
dung cach theo muc dich s dung, theo
cac hudng dan hoat déng cung véi viéc
xuét trinh hoa don gbc hodc bién nhan
tién mat ghi rd ngay mua, tén ngudi ban,
mau ma va ma sb san xuét clia san pham.

1.1 Lwu y an toan va bao dwéng

® canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu ré trong tai liéu nay cé thé
khién nguwoi dung dé bj dién giat, gap cac
rai ro vé dién va/hodc co hoc.

Hay doc va thuc hién theo cac hwéng dan
sau khi két ndi va st dung man hinh may
tinh:

Hoat dong

« Hay dat man hinh & khu vwc khéng cé
anh sang trwe tiép ctia mét, anh sang
ric c6 cweng d6 manh va cach xa
b4t ky ngudn nhiét nao khac. D&t man
hinh 1au ngay trong mai tredng nay co
thé khién cho man hinh bi bac mau va
héng.

+ Di chuyén moi d vat c6 thé roi vao
céac 16 théng gié ctia man hinh hoac
ngan can qua trinh lam mat thich hop
cla c4c thiét bj dién t&r bén trong man
hinh.

+ Khéng bit kin cac 16 théng gio6 trén vé
man hinh.

«  Pam bao d&t man hinh & gan noi co6
phich c&m va & cdm dién.

« Néu tat man hinh bang cach rat cap
ngudn hodc day dién DC, hay doi 6
giay truwéc khi cdm cap ngudn hodc
day dién DC @& man hinh hoat déng
binh thuwong.

+ Hay ludn dung cap ngudn chun dwoc
cép bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tam thong tin tiéu dung
cham séc khach hang)

+ Khéng dat man hinh & noi bj chan
dong hay va cham manh khi dang
hoat dong.

+ Khong dap hoac lam roi man hinh khi
dang hoat dong hoéc khi di chuyén.

Bao dwdng

« D& man hinh khéng bj héng, khong dé
nén qua manh Ién mat man hinh LCD.
Khi di chuy&n man hinh, hay ndm chat
khung man hinh dé nhéc Ién; khéng
nh&c man hinh bang cach d&t ban tay
hodac ngén tay Ién mat man hinh LCD.

Rt phich cdm man hinh néu ban khéng
dinh str dung né trong th&i gian dai.

« Rt phich cdm man hinh néu ban can
lau chui man hinh bang mét miéng
vai hoi wét. Ban co thé lau man hinh
béng vai kho khi d& ngét dién. Tuy
nhién, dng bao gi& dung dung moi
hiru co, chang han nhuw cdn hodc cac
chét Idng c6 ngudn gbc tir amoniac dé
lau man hinh.

«  Pé tranh nguy co bi dién giat hoac
hdéng vinh vién bé man hinh, khéng
dat man hinh & noi ¢d bui, mwa, nwdc
ho&c & noi qua am wot.

« Né&u man hinh bj wét, hay lau né bang
vai kho cang sém cang tét.

« Néu chét la hodc nwéc dinh vao man
hinh, hay ngét dién ngay va rat cap
ngudn. Sau do lau sach chét la hodc
nwée rdi glvi man hinh dén trung tam
bdo dwong.



+ Khéng cét gitr ho&c str dung man hinh
& noi co ngudn nhiét, anh néng truc
tiép hodc qua lanh.

+ D& duy tri hoat ddng téi wu clia man
hinh va st dung né trong thoi gian dai,
hay dung man hinh & noi nam trong
gi6i han nhiét d6 va d6 4m sau.

« Nhiét d6: 0-40°C 32-95°F
+ D06 &m: 20-80% RH

+ LUU Y: Luén bat trinh bdo vé man
hinh chuyén déng khi ban khéng st
dung man hinh. Luén bat vng dung
lam mé&i man hinh dinh ky, néu khong,
man hinh clia ban sé hién thi nhirng
ndi dung tinh khong thay ddi. Hién thj
lién tuc cac anh tinh trong mét thoi
gian dai co thé gay ra hién twong “anh
thtr néng”, con dwoc goi la “anh ao”
hay “anh bong ma”, trén man hinh cta
ban.

“Anh th&r néng”, “Anh a0” hay “Anh
béng ma” 1a hién twong phd bién trong
céng nghé man hinh LCD. Trong hau
hét cac trwdng hop, hién twong “anh
thlr ndbng” hodc “anh 40” hay “anh
béng ma” sé& dan dan bién méat sau
mét thdi gian man hinh bj ngét dién.

@ canh bao

Cac hién twgng “anh thir nong” hay “anh
40” hay “anh bong ma” sé& khong biét méat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng ndm trong chinh sach
bao hanh cua chung toi.

Dich vu

» Chinhan vién dich vu chuyén mén
maoi dwoc mé vo boc man hinh.

« Né&u can moi tai liéu hwéng dan dé
stra chira hodc tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (vui Idng tham khéo
chwong “Trung tdm théng tin tiéu
dung”)

«  Dé biét thong tin vé viéc van chuyén,
vui long tham khao muc “Théng sb k§
thuat”.

« Khéng dat man hinh trong xe hoi/cép
xe dwdi anh nang truc tiép.

& Ghi chu

Hay tham khao y kién cla k¥ thuat vién
dich vu néu man hinh khéng hoat déng
binh thudng hodc néu ban khéng chac
phai thwc hién quy trinh nao khi da lam
theo cac hwéng dan hoat déng néu trong
s6 tay nay.

1.2 Mb ta biéu twong

Cac muc phu sau day mé ta cac quy woc
vé biéu twong dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sb tay nay, cac doan chi®
c6 thé di kém biéu twong va dwoc in dam
ho&c in nghiéng. Cac doan nay bao gdm
cac ghi chu, lwu y hodc canh bao. Ching
dwoc str dung nhu sau:

& Ghi chu

Biéu twong nay cho biét cac thong tin
quan trong va cac bi quyét gidp ban tan
dung tét hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac thong tin gitp
ban biét cach tranh dwoc sw ¢ héng hoc
tiém &n ddi v&i phan clrng hodc mat di
liéu.

® canh bao

Biéu twong nay cho biét sy tdn thwong
co thé tiém an va gitp ban biét cach tranh
dwoc sw cb do.

Mét s6 canh bao co thé xuét hién & nhiéu
dinh dang va c6 thé khéng di kém mot
biéu twong. Trong nhirng trwéng hop nay,
céach thirc trinh bay cu thé cta canh bao
dé dwoc quy dinh b&i co quan chirc nang
lién quan.



1.3 Virt bé san pham va vat liéu
dong goi

Thiét bj dién & dién te bj virt bo-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling.




2. Cai dat man hinh Hl Lapchandé ‘
1. Dat man hinh nam sap trén bé mat
mém min, cn than dé tranh lam tray

2.1 Lap dat xwdc hodc héng man hinh.
2. Gén try dé git vao man hinh cho dén
1] Noi dung go6i hang khi n6 khéa vao thich hop.

QS‘Eart

PHILIPS

3. Gilr chan dé man hinh bang ca hai tay
va |&p chat chan dé vao tru dé.

VGA (tuy chon) DVI (tuy chon)



El Két néi véi PC

PHILIPS

@ DAiu vao ngudn dien AC

© Diu vao VGA

© Dau vao DVI-D (co6 sén cho cac mau
vira chon)

@ Dau vao am thanh (c6 sén cho cac
mau vira chon)

© Khoa chdng trdm Kensington

Két néi véi PC

1. C&m chét cap ngudn vao mét sau cla
man hinh.

2. T4t may tinh va rat cap ngudn.

3. Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

4. Cam cap nguon ctia may tinh va cap
nguon cdia man hinh vao 6 cam dién
gan do.

5. Bat may tinh va man hinh. Néu man
hinh hién thi hinh anh thi qua trinh cai
dat da hoan tat.

2.2 Str dung man hinh

El M6 ta mat trwéc cha san pham

nnnnnn

Mau 190V3LA:

(5]
AUITO/V -Iﬂ /A /O/; @{OK (l|)
(/] (6 (4 T 3) (2] o
Mau 190V3L:
(5]
AUTO/ W /A /0/4\ @{OK (||)
(7] (6] o 6 o o
BAT va TAT ngudn man
| .
o O hinh.
Truy nhdp menu OSD.
© | ©/0K|Xac nhan diéu chinh menu
OSD.
©| 4« |[Trédvé mic OSD trudec.
©® | & [Chinh d6 sang.
© | A V¥V Chinh menu OSD.
1l |Chinh am Iwgng loa.
e 2 2
o |Dai dinh dang hién thi.
©@ | AUTO | Tw dong chinh man hinh.




El M6 ta menu Hién thij trén man hinh Menu OSD

Hién thi trén man hinh (OSD) Ia gi? Duéi day Ia tong quan vé co cau clia
Hi&n thi trén man hinh (OSD) & mét tinh iy Hien thi trén e htlr?ﬁ' Bf.'” i the
nang c6 & moi man hinh LCD ctia Philips. St dung co cau nay fam fhong fin tham
N6 cho phép ngudi dung didu chinh hoat khgo khi mL‘Jon thwe hién cac diéu chinh
dong clia man hinh hogc chon cac chirc khac sau nay.

nang cua man hinh trie tiép théng qua
mot clra s6 hwdng dan hién thj trén man
hinh. Mot giao dién hién thi trén man hinh R v
dé st dung dwoc thé hién nhw sau: b bvi

x (available for selective models)
Mau 190V3LA:

i . — Picture Format — Wide Screen, 4:3
« Input - +— Picture
L - — Brightness — 0~100

Main menu Sub menu

j FIetE . — Contrast — 0~100
L— SmartContrast — On, Off

— Volume — 0~100

[— Audio — Stand-Alone — On, Off

— Mute — On, Off

(available for selective models)

— Color Temperature — 6500K, 9300K
— Color
— sRGB
—— User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Francais, Deutsch, Italiano,

Portugués, Pycckuin, BIRHR3L, Tirkge

— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
Picture Format . creen
Brightr < LI 1o — Transparency — Off,1,2,3,4
SmartContrast . L'HI II = T OSD Tlme OUt T Ss' 105' 205' 305, 6os
Languagd e L Sewp — Auto
0SD Settings ‘ — H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
, = > N . A . — Clock — 0~100
Hwéng dan co ban va don gian vé cac “
nﬁt diéu khlén — Resolution Notification — On, Off
Trong menu OSD minh hoa & trén, ban co [ Reset — Yes,No
thé nhan Y A cac nat & g& mat trwéc cla L Information

man hinh @& di chuyén con tr6 va nhén nut
OK dé xac nhan Iya chon hodc thay doi.



El Théng bao vé dé phan giai

Man hinh nay dwoc thiét ké d& hoat déng
tdi wu v&i d6 phan gidi gbc 1a 1440 x 900
@ 60 Hz. Khi dwgc chinh sang dd phan
giadi khac, man hinh sé hién thi mot thong
bao: Dung 1440 x 900 @ 60 Hz dé dat
két qua tét nhat.

Ban c6 thé tat thong bao hién thi d6 phan
gidi goc tir muc Setup (Cai dat) trong
menu OSD (Hién thj trén man hinh).

El Tinh nang vat ly
Nghiéng

2.3 Thao dé va chan dé

B Thao chan dé

Trwéc khi bat dau thao chan dé man

hinh, hay thwe hién theo cac hwéng dan

bén dwai dé tranh moi thiét hai hay chan

thwong cé thé xay ra.

1. Dat man hinh ndm sip trén bé mat
min, c&n than d& tranh lam tray xwéc
hodc héng man hinh.

2. An vao cac kep khéa dé thao chan dé
ra khoi tru dé.




H Thao d@é

1. Ban c6 thé& sir dung tua vit dau det dé
4n vao hai khép nha trén nap ban 1&
va cay nhe ndp ban 1& dé thao no ra.

2. Théo 4 dinh vit rdi thao chan dé ra
khéi man hinh.




3. T6i wu hoa hinh anh

3.1 SmartContrast

B polagi?

Co6ng nghé ddc dao vén linh hoat phan
tich ndi dung hién thij va tw dong tbi wu
héa ty Ié twong phan cia man hinh LCD
dé mang lai d6 rd nét va trai nghiém xem
tdi wu, tang mirc dén nén dé hién thi
nhirng hinh anh sang ré hon, sic nét hon
va sbng déng hon hay gidm mirc dén nén
d& hién thi rd hinh anh trén phong nén ti.
E Sao t6i phai can n6?

Ban mudn hién thi ndi dung ré nét cing
cam giac thodi mai nhat khi xem moi loai
ndi dung. SmartContrast sé linh hoat chinh
d6 twong phan va mirc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwe ré, sdng déng va sac nét hay hién thi
ndi dung chir rd rang dé doc cho céac trng
dung van phong. Béng cach gidm viéc tiéu
thu dién ctia man hinh, ban sé tiét kiém
dworc chi phi ndng lwong va kéo dai tudi
tho cho man hinh cuta ban.

E cach hoat dong?

Khi ban bat ché d SmartContrast, n6 sé
phan tich néi dung dang hién thj trong
thwe té dé chinh mau séc va mat do den
nén. Chirc nang nay sé linh hoat téng
do6 twong phan dé mang lai cho ban trai
nghiém giai tri tuyét v&i khi xem video
hoac choi game.

3.2 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i cta
Phillips cho phép ban diéu khién man hinh
qua giao dién dd hoa o tién dung. Cac
diéu chinh phtc tap la nhirng gi thudc

vé qua khir vi phan mém than thién voi
nguoi dung nay sé& huéng dan ban qua
viéc tuy chinh do phan gidi, hiéu chinh
mau, diéu chinh déng hd/géc pha, diéu
chinh diém trang RGB (Dé-Luc-Lam), v.v...

Trang bi cdng nghé méi nhét vé thuat toan

I6i xt Iy va phan ng nhanh, phan mém

chay bang anh déng b4t mat thuong thich

véi Windows 7 nay sé&n sang nang cao trai

nghiém cuta ban v&i man hinh Philips!

B cai aat

« Thuc hién theo chi d&n va hoan tat quy
trinh cai dat.

« Ban c6 thé kh&i dong phdn mém sau
khi hoan tat cai dat.

«  Néu mubdn kh&i ddng sau, ban c6 thé
click phim tat phdn mém trén man hinh
nén hoac thanh céng cu may tinh.

PHILIPS s g e aizzire

Wizard (Thuat si) kh&i dong lan dau

 Lan dau khi cai d&t phan mém
SmartControl Lite, nd sé ty dong vao
Wizard (Thuat si) khéi déng lan dau.

+ Thuat si nay s& hwdng dan ban théng
qua viéc diéu chinh tirng buéc vé hiéu
suét man hinh.

+ Sau nay ban ciing c6 thé vao menu
Plug-in (B4 sung) dé bat thuat si.

« Ban c6 thé chinh cac tuy chon khac
qua giao dién Standard (Chuan) ma
khong can thuat si.



. T6i wu héa hinh anh

[~ P 3 - Pt 12501 L30T S000000) (B8 W el 3 - Pt 12501 te3e7is000001) (%
SmartControl Lite PHILIPS SmartControl Lite PHILIPS

Wizard
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N . . B Sarttzenl 3- Phien 12501 (CE071500¢ M
Bl Khéi dong béng giao di¢n Standard SmartControl Lite PHILIPS
(Chuan): oo
Menu Adjust (Piéu chinh): ' Y B e
+  Menu Adjust (Bidu chinh) cho phép J P s o s .
ban chinh Brightness (D6 sang), s 3 iR
Contrast (B¢ twong phan), Focus \5 a-
(Trong tam), Position (Vi tri) va e ﬁ
Resolution (B4 phan giai). g Tt
* Ban ¢ thé Iam theo chi dén va thuc \? 2
hién diéu chinh. k.4
¢ Lénh Cancel (Huy) sé h6i nguoi dung \9
xem ho cé muon hay tién trinh cai dat -
hay khong.
— T
[~ - 31 i 1751 fes3mris0000n1) () %
SmartControl Lite PHILIPS ;
SmartControl Lite PHILIPS
s
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+ s &
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3. T6i wu héa hinh anh

B Sarttzenl 3- Paden 22901 (rssetL3000001) () B Sartczerl 3- Paign 12501 (esaeriso0001) ()
SmartControl Lite PHILIPS SmartControl Lite PHILIPS

Resolution White Point
Wiite Pont &

[ - Pl 2251 (SIRTLS00000) (it

Menu Color (Mau): SmartControl Lite PHILIPS

* Menu Color (Mau) cho phép ban chinh
mau RGB (Dé-Luc-Lam), Black Level
(Do tbi), White Point (Diém tréng),

Displiy Gammia

Color Call?ratlon (Hiéu ch|~nh mau). m ”
»  Ban c6 thé lam theo chi dan va thuwc “‘I"
hién diéu chinh. \5 Y
+ Tham théo bang bén dudi dé hinh e * 0
dung co ban vé muc menu phu trén \g g -
théng tin nhap cua ban. e oo o
* Vidu (;olor Calibration (Hiéu chinh \Q
mau sac): =
[P 3- Paign 37901 (E53eT13000001) ()
SmartControl Lite PHILIPS
Black Lovel [ ot 3 - P 2290 (05 cont) (T
B e SmartControl Lite PHILIPS
m !‘! Calibration
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1.

“Show Me” (Cho t6i xem) sé bat
hwéng dan hiéu chinh mau.

Start (Bat d4u) - bat dau quy trinh
canh chinh mau qua 6 buwéc.

Quick View (Xem nhanh) tai cac hinh
anh trwéc/sau.

Tré vé giao dién chinh Color (Mau),
click nat Cancel (Huy).

Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khéng chon muc nay, ban
khong dwoc phép hiéu chinh mau va
tat cac nut khéi dong va xem nhanh.
Phai c6 théng tin bang sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

Nt Previous (Trwéc) sé tat cho dén
khi man hinh mau th hai bat 1én.
Next (K& tiép) s& chuyén vao muyc tiéu
tiep theo (6 muc tiéu).

Cubi cung,yéo giao dién File>Presets
(File>Cai san).

Nut Cancel (Hay) sé dc')ng giao di{an
ngwdi dung (Ul) va tré vé trang bd
sung.

12

Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat dong khi chon
Preferences (Ju tién) ttr menu Options
(TUy chon) sb xudng. Trén man hinh
khéng héd tro twong thich véi chudn DDC/
Cl, chi c6 sén cac thé Help (Tro gitp) va
Options (Tuy chon).

[ pEser 3 - g 17981 [£53571 3008 7

SmartControl Lite PHILIPS

&
. . |

s L

e

Optiong Pranes

‘a

e

=

*  Hién thi cac cai d&t wu tién hién hanh.

« O vira chon sé bat tinh nang nay. O
chon 1a nut bat/tat.

» Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai sén)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (Da tét)
sé x6a SmartControl Lite khéi menu
thudc tinh click phai.

+ Biéu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bat) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thj cac tuy chon menu
cho Help (Tro giup), Technical Support
(H6 tro’ ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi da tat Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thi EXIT
(THOAT).

e Theo mac dinh Run at Startup (Chay
khi khé&i déng) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé khong
bat khi khéi ddng hodc nam trong
khay tac vu. Cach duy nhat dé bat
SmartControl Lite 1& tlr phim tat trén
man hinh nén hoéc ti file chuwong
trinh. Bat ky bo cai dat sdn nao dé
chay khi kh&i dong sé hoat déng
khéng tai khi 6 nay khong dwogc chon
(Pa tat).

« Enable transparency mode (Bat ché
do trong subt) (Windows 7, Vista, XP).
Mac dinh Ia 0% Mo.

Options>Input (Tuy chon>Nhap) - Sé

chi hoat déng khi chon Input (Nhap) ti

menu Options (Tuy chon) sb xudng. Trén
man hinh khéng hé tro twong thich véi
chuén DDC/CI, chi ¢ sén cac thé Help

(Tro gitp) va Options (Tuy chon). T4t ca

céac thé SmartControl Lite khac déu khong

c6 sén.

PHILIPS

+ Hién thi giao dién hudng dan Source
(Nguon) va cai dat nguon nhap théng
tin hién hanh.

* Trén cac man hinh nhap riéng, giao
dién nay sé khong hién thi.
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Options>Audio (Tuy chon>Am thanh)
- Sé chi hoat dong khi chon Audio (Am
thanh) tir menu Options (Tuy chon) sb
xubng.

Trén man hinh khéng hé tro twong thich
v&i chudn DDC/CI, chi c6 s&n cac thé
Help (Tro giup) va Options (Tuy chon).

[ 1 . 7
PHILIPS

SmartControl Lite

Help>User Manual (Tro’ gitip>S6 tay stv
dung) - Sé chi hoat dong khi chon User
Manual (Sb tay st dung) t& menu Help
(Tro gitp) s6 xubng. Trén man hinh khong
hé tro twong thich véi chudn DDC/CI, chi
c6 sén cac thé Help (Tro giup) va Options
(Tay chon).
W

SmartControl Lite

PHILIPS

User Manual

=

i
=2 8 e
£

in

g

it



Help>Version (Tr¢ giup>Phién ban) - S&é
chi hoat déng khi chon Version (Phién
ban) tr menu Help (Tro gitp) sé xubng.
Trén man hinh khéng hé tro' twong thich
v&i chudn DDC/CI, chi c6 s8n cac thé
Help (Trg gitp) va Options (Tuy chon).

it
PHILIPS

SmartControl Lite

= :

Menu nhay cam vé&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thudc tinh) s& dwoc Bat. Néu
da chon Enable Context Menu (Bat thuéc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

@ SmartControl
Select Preset 3
Tune Display

Menu Thudc tinh c6 ba muc nhéap:

« SmartControl Lite - khi da chon, About
Screen (V& man hinh) s& hién thj.

+ Select Preset (Chon cai dat sén) -
Cung cAp menu cac muc cai san da
lwu theo trinh tw dé& s dung ngay.
D4u kiém s& hién thi muc cai s&n hién
da chon. Muc Factory Preset (Cai sén
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gbc) cling co thé duoc chon tir menu
s6 xubng.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

+  Smartlmage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

Da bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao bidu twong
SmartControl Lite ttr khay tac vu. Click trai
sé bat irng dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

* Help (Trg giup) - Truy cap file User
Manual (Sé tay st dung): M& file User
Manual (Sé tay st dung) qua ctra s
trinh duyét mac dinh.

+ Technical Support (H8 trg’ ky thuat) -
hién thj trang hd trg ky thuat.

+  Check for Update (Kiém tra cap nhat)
- d&n nguwoi dung dén Nén (rng dung
PDI va kiém tra phién ban clia ngui
dung so vé&i phién ban c6 s&n méi
nhét.

* About (V&) - Hién thi thong tin tham
khdo chi tiét: phién ban san pham,
théng tin vé phién ban va tén san
pham.

» Exit (Thoat) - Béng SmartControl Lite.

pé chay lai SmartControl Lite, hdy chon
SmartControl Lite ttr menu Program
(Chwong trinh), click ddi biéu twong PC
trén man hinh nén hoac khai dong lai hé
théng.



PHILIPS

SmartControl

]
Version 3.0
eftune=standard-AI007 01 0d=11 $1.23
Copyright 16632007 Portrast spdarys, inc.
Fatarts Penang

P4 tat menu khay tac vu

Khi da tit Khay tac vu trong thu muc

wu tién, chi con co sén lwa chon EXIT
(THOAT). B& x6a hoan toan SmartControl
Lite khoi khay tac vu, hay tat Run at
Startup (Chay khi khé&i ddng) trong
Options>Preferences (Tuy chon>Uu tién).
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4. Cac théng so ky thuat

Loai mat man hinh TFT-LCD

Deén nén LED

C& man hinh Roéng 19 inch (48,3cm)
Hé sb co 16:9

Do pixel 0,2835 x 0,2835 mm
Do sang (chuén) 250 cd/m?

Do twong phan thong minh 10,000,000:1

Do twong phan (chuan) 1000:1

Thoi gian dap (rng (chuén) 5ms

D6 phan giai toi wu

1440 x 900 @ 60Hz

Gobc xem

176° (H) / 170° (V) @ C/R > 10

Mau man hinh

16,7 triéu mau

DAu vao tin hiéu

Téc d6 phat doc 56Hz - 76Hz
Tan s6 ngang 30kHz - 83kHz
sRGB (Pé-Luc-Lam chuadn) | CO

DVI (KTS), VGA (Analog)

Tin hiéu vao

Tién ich cho ngudi dung

Ddng bo riéng, Bdng bd véi tin hiéu xanh luc

190V3LA: Auto/w
190V3L: auto/Ww

(/A
0/A

0-/4
0/ 4

/0K
/0K

O
O

Ngén ngir OSD (Hién thj trén
man hinh)

Tiéng Anh, Tiéng Phap, Tiéng Dlrc, Tiéng Tay Ban Nha,
Tieng Y, Tiéng Nga, Tieng Hoa Gian thé, Tiéng B6 Pao
Nha, Tiéng Thd Nhi Ky

Tién ich khac

Khbéa Kensington

Twong thich véi chuén Plug
& Play (Cam vao la phat)

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Nghiéng -5/ +20
190V3LA:
Ché do bat 20,70W (chuan), 24,32W (t6i da)

’ Dién 4p dau vao | Dién ap dau vao | Dién ap dau vao
Tiet kiém nang lwong AC voi cong AC voi cong AC voi cong
(Phwong phap thlr nghiém suat 100VAC suat 115VAC suat 230VAC
EnergyStar 5.0) +/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz

+/- 3Hz +/- 3Hz +/- 3Hz
Hoat dong thong thuong | g ooy 17,90W 17,85W
(chuan)
Ché d6 ngu (chd) 0,5W 0,5W 0,5W
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T4t 0,5W 0,5W 0,5W
Dién ap ddu vao | Pién ap dau vao | Dién ap dau vao
AC voi cong AC vGi cong AC v6i cong
Tan nhiét* suat 100VAC suat 115VAC suat 230VAC
+/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz
Hoat déng thong thwong 61,43 BTU/gi& 61,09BTU/gio 60,92 BTU/gi®
Ché dd ngu (cho®) 1,706 BTU/gi® 1,706 BTU/gi®y 1,706 BTU/gi®
Tat 1,706 BTU/gi® 1,706 BTU/gio 1,706 BTU/gi®
DPén bao LED nguén Ché do6 bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)
Bo nguc‘“)n Thr néng, 100-240VAC, 50/60Hz
190V3L:
Ché d6 bat 20,70W (chuén), 21,48W (t6i da)

Tiét kiém n&ng lvong
(Phwong phap thtr nghiém

Dién ap dau vao
AC vé&i cong
suat 100VAC

Dién ap dau vao
AC v&i cong
suét 115VAC

Dién ap dau vao
AC vé&i cong
suat 230VAC

EnergyStar 5.0) +/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz

Hoat dong thong thuong | g oy 17,90W 17,85W

(chuan)

Ché d6 ngu (chd) 0,5W 0,5W 0,5W

Tét 0,5W 0,5W 0,5W
Dién ap dau vao | Dién ap dau vao | Dién ap dau vao
AC voi cong AC vGi cong AC v6i cong

Tan nhiét* suat 100VAC suat 115VAC suat 230VAC
+/-5VAC, 50Hz | +/-5VAC, 60Hz | +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz

Hoat déng théng thweng 61,43 BTU/gi® 61,09 BTU/gi®> 60,92 BTU/gi®>

Ché d6 ngt (chd) 1,706 BTU/gi>» 1,706 BTU/gio 1,706 BTU/gio»

Tat 1,706 BTU/gio» 1,706 BTU/gio 1,706 BTU/gio»

Dén bao LED nguén Ché do6 bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)

Bo nguén Thr néng, 100-240VAC, 50/60Hz

San pham kém theo dé gitr
(Rdng x cao x day)

462 x 383 x 199 mm

San pham khong kém theo

462 x 319 x 47 mm

dé giv (Rong x cao x day)

San pham kém theo dé gitv | 3,05kg

gf\n Bham khéng kem theo 2,80kg
e gilr

San pham déng goi 3,93kg




4. Cac thong

Pham vi nhiét 6 (hoat dong)

0°C-40°C

Pham vi nhiét d (Khong
hoat dong)

-20°C-60°C

Do am twong déi

20% - 80%

b6 cao

Hoat dong: + 365.760,00cm (3.658m)
Khoéng hoat dong: + 1.219.200,00cm (12.192m)

MTBF (Thoi lwvong ’trung
binh gilra cac sw co)

30.000 gioy

Chi thi ROHS (Gi¢i han cac

chét gay hai) €9
EPEAT Bac (www.epeat.net)
Thung dung Co thé tai ché 100%
CE Mark, FCC Class B, GOST, SEMKO, TCO Certified
Phé chuén theo quy dinh (Only for selective models), UL/cUL, BSMI, 1ISO9241-307
CB,Energy star 5.0,PSB,CCC,CECP
Mau Den

L&p son ngoai

Bong lang/Hoa van

© Ghichu

1.

N

Vang hay bac EPEAT chi c6 hiéu lwc tai noi ma Philips da dang ky san pham. Hay truy

cap www.epeat.net dé biét tnh trang d&ng kw tai quéc gia ctia ban.

D@ liéu nay chju sw thay ddi ma khéng can théng bao trwéc. Truy cap www.philips.com/

support dé tai vé& phién ban td roi méi nhét.




4.1 Ché do do phan giai & cai
dat san
E D6 phan giai t6i da
1920 x 1080 @ 60 Hz (d4u vao analog)
1920 x 1080 @ 60 Hz (d4u vao KTS)

E P phan giai khuyén diing
1440 x 900 @ 60 Hz (d4u vao KTS)
Dinh gi® hé tro VGA

3147 720 x 400 70,09
31,47 640 x 480 59,94
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
49,70 1280 x 800 59,81

63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03

55,94 1440 x 900 59,89
64,67 1680 x 1050 59,88
65,29 1680 x 1050 59,95

67,50 1920 x 1080 60,00

& Ghi chu

Lwu y réng man hinh cla ban hoat déng
tbt nhat & do phan giai gbc 1440 x 900
@ 60Hz. D& co6 chét lwong hién thi tbt
nhét, hay dung dé phan giai khuyén nghi
nay.
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5. Quan ly nguén dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh c6 thé tw ddng giam
tiéu thu dién khi khéng sr dung. Néu phat
hién nhap ttr ban phim, chudt hay thiét bi
nhap khac, man hinh sé “hoat dong” tw
doéng. Bang sau day sé hién thi mae tiéu
thu dién va cach truyén tin hiéu cla tinh
nang tiét kiem dién tw ddng nay:

190V3LA:

Ché do Video Ddng bd| Bong | Ngudn dién | Mau dén
VESA ngang | bo doc str dung LED
_ 20,7W ,
Hoat dong| BAT Co Co (chuén) Trang
Chédd | -, <osw | Trén
ngti (ch®) TAT | Khéng | Khéng (chl;én) (Nhap
nhay)
Tt | TAT| - - SO TAT
(chuan)
190V3L:

Ché do Video Doéng bd| Béng | Ngudn dién | Mau dén
VESA ngang | bo doc st dung LED
Hoat dong| BAT | Co Co (23;32{1) Tréng
chéds | <osw | Téng
o (chi‘y ) TAT | Khéng | Khéng (Chl’Jén) (Nhap
nhay)
Tat | TAT SeRw TAT
(chuan)

Cai dat sau day dwoc dung dé do murc

tiéu thu dién trén man hinh.

« Do phan giai gbc: 1440 x 900

+ Do twong phan: 50%

* D9 sang: 250 nit

. Nhiét dg} mau: 6500k v&i kiéu mau
trang day du

& Ghicha

D@ ligu nay chiu sy thay ddi ma khéng

can théng bao trudrc.
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6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!
This display is designed for both you and the

planet

carries the TCO Certified label.
This ensures that your display is

designed, manufactured and tested according to

some of the strictest quality and environmental

requirements in the world. This makes for a high

performance product, designed with the user

in focus that also minimizes the impact on the

climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the
TCO Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.
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*  Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of
the TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

e Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

*  Both product and product packaging is
prepared for recycling.

*  The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is
now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

I[u Technology for you and the planet
CERTIFIED

(Only for selective models)



EPEAT

(www.epeat.net)

ow, e EPEAT (Electronic Product
Qe,'b Environmental Assessment Tool)
% program evaluates computer

desktops, laptops, and monitors
based on 571 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

»  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

»  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

*  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

* 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

»  GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

» TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner; we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

6 Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Thong quy dinh

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic
Only)

“This davice belongs to catagory B devices as described in EN 55022, unless it is spacii-
cally stated that it ia a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The ussr of the
davics is obligad to take all staps necessary o remove sources of interfarance to tels-
communication or ather devicas.

Pokd neni na fypovém &ithu potstase uvedena, #e spedé dodo tiidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 55022 platl nésleduficl. Dojde-ii k rullan! telskomunikatich nebo
finjich zafizeni e uivatal povinnen provést takova opatfgni, atry rueni odstranil,

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
STOMTILF@RSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)
RRZHENERIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

() ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



6. Thong tin quy dinh

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh
man hinh phéng cua Philips
Philips cb géng cung cAp cac san phdm
chat lvong cao nhét. Chung t6i ap dung
mét sé quy trinh san xuét tién tién nhét
trong Iinh vuc va thuwe hién quy trinh kiém
tra chét lwong nghiém ngat. Tuy nhién, cac
I6i diém &nh hay diém anh con trén man
hinh TFT dung trong cac man hinh phang
ddi khi khéng thé tranh khéi. Khong nha
san xuat nao cé thé dam bao réng moi man
hinh s& khong ¢ cac 16i diém anh, nhwng
Philips dam bao réng bét ky man hinh nao
c6 mot sb 16 khong thé chap nhan sé duoc
slra chi*a hodc thay méi dwa vao chinh
sach bao hanh. Thong bao nay giai thich
nhirng kiéu I6i diém anh khac nhau va dinh
nghia cac murc 16i c6 thé chap nhan cho
moi kiéu 16i. D& hwéng dich vu stra chira
hay thay thé theo chinh sach bao hanh, sé
lwong 16i diém &nh trén man hinh TFT phai
vuwot qua cac mire chap nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh c6 thé bj I6i. Ngoai ra, Philips tham
con dat ra cac tiéu chuan chét lweng cao
hon cho mét s6 kidu hay két ho’p 16i diém
anh vbn dé& nhin thay hon cac kiéu 15 khac.
Chinh sach nay cé hiéu Iyc trén toan cau.

diém  didm  didm
anh phu anh phu anh phu

H H \x
diem
anh

DPiém anh va diém anh con

Diém anh hay phan t&r anh gébm ba diém
anh con trong cac mau chinh da, luc va
lam. Nhiéu diém &nh ciing tao thanh hinh
anh. Khi moi diém &nh con cia mot diém
anh sang Ién, ba diém anh con c6 mau sac
cuing hién thi nhw mot diém anh trang don
1&. Khi moi diém anh con t6i m&, ba diém

anh con c6 mau sac cung hién thi nhw mot
diém &nh den don 1&. Nhiing két hop diém
anh con sang va toi khac hién thi nhw cac
diém anh don 18 tir nhitng mau khac.

Cac kiéu 16i diém anh

Cac 16i diém &nh va diém anh con hién thj
trén man hinh theo nhirng cach khac nhau.
C6 hai kiéu 16i diém anh va nhiéu 16i diém
anh con trong méi kiéu I5i.

Cac 16i cham sang

Cac 16i chdm sang hién thi dugi dang cac
diém anh hay diém anh con vén ludn sang
hay “bat”. Nghia la mon ch&m sang 1a mot
diém anh con vén ndi lén trén man hinh khi

man hinh hién thi kiéu hinh t&i mo. Cé cac
kidu 16i chAm sang.

Mbt diém &nh con sang dd, luc hay lam.

|l -

Hai diém anh con sang gan nhau:
bé + Lam =Tim
bé + Luc = Vang
Luc + Lam = Lyc lam (Lam nhat)

Ba diém anh con sang gan nhau (mét diém
anh trang).




© Ghi chu

Cham sang d6 hay lam phai sang hon
50% so v&i cac chAm xung quanh trong
khi chAm sang luc sang hon 30% so Voi
cac chdm xung quanh.

Cac 16i cham den

Cac 16i chdm den hién thi dwéi dang cac
diém anh hay diém anh con vén luén téi
mo hay “t&t”. Nghia 1a mdi cham tbi me
la mot diém anh con vén ndi 1én trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 cac kiéu 16i cham den.

D6 gan cua cac 16i diém anh

Vi céc 16 diém anh va diém anh con cla
cuing kiéu 16i vén gan véi mét kiéu 16i khac
c6 thé dé nhin thay hon, Philips cting néu
rd cac dung sai vé d6 gan cla 16i diém anh.

Dung sai 16i diém anh

DPé huwdng dich vu stra chira hay thay

thé do cac 16i diém anh trong thdi han

bdo hanh, man hinh TFT trong man hinh
phang Philips phai c6 cac 16i diém anh hay
diém anh con vwot qua nhitng dung sai
néu trong cac bang sau.

° A A AP A
1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (mét diém anh tréng) 0
Khoang cach gitra hai I6i chdm sang* >15mm
Tbng sb 16i chAm sang ctia moi kiéu 16i 3

O AM B Ap
1 diém anh con t6i m& 5 hodc it hon
2 diém anh con t6i m¢& gan nhau 2 hodc it hon
3 diém anh con t6i m& gan nhau 0
Khoang cach gitva hai I6i chdm den* >15mm
Téng s6 16i chdm den clia moi kiéu I5i 5 hosc it hon

TONG SO LOI CHAM

MUC CHAP NHAN

Téng sb 16i chAm sang hay den clia moi kiéu I6i

5 hoac it hon

& Ghichu

1. 1 hay 2 16i diém &nh con gan nhau = 1 16i chdm
2. Man hinh nay tuan tha chuén 1S09241-307. (1IS09241-307: Yéu cau, phan tich vé hiéu
néng va cac phuwong phap kiém tra tuan tht cho man hinh dién td)
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7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 théng tin chi tiét vé chinh sach bdo hanh va yéu cau hd tro thém dwoc ap dung cho
khu vire clia ban, vui long truy cap website www.philips.com/support. Ban ciing c6 thé lién
hé v&i Trung tdam cham soc khach hang dia phwong cda Philips theo so dién thoai dwéi

day.

Théng tin lién lac cho khu vec TAY AU:

QQuocC gia 0 O a 0

Germany Siemens 1&S +49 01803 386 853 €0.09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0.08
Netherlands E Care +31 0900 0400 063 €0.10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €0.07
Belgium E Care +32 078 250851 €0.06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Théng tin lién lac cho khu viec TRUNG VA DONG AU:

A 0 1d O

QUOoC gia q 3 0 3 O a ang
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
fﬂirnbt':n&egro NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
Ui NA Comel +380 562320045
NA Topaz-Service Company |+38 044 245 73 31
Russia NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. |[NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary - :
NA Profi Service +36 1 814 8080

Théng tin lién lac cho khu viec CHAU MY LATINH:
Trung tam dich vu

Quéc gia

Brazil

Argentina

Vermont

S6 cham séc khach hang
0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

Trung Quéc

Sé cham soc khach hang: 4008 800 008

Thoéng tin lién lac cho khu viec NAM MY:

(Quo gla O Z 0 a ang
U.S.A. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Théng tin lién lac cho khu viec Chau A TBD/Trung Bong/Chau Phi (APMEA):

- 0 1d O

(QuocC gia 0 a 0 a ang
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Smart Pixels Technology Hong Kong:Tel: +852 2619 9639
Macau Ltd. Macau:Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika | Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea |NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics
Singapore NA Singapore Pte Ltd (Philips | (65) 6882 3999
Consumer Care Center)
PCCW
Taiwan Teleservices |FETEC.CO 0800-231-099
Taiwan
Thailand | NA ﬁ’;‘s Computer System Co., | 651 934-5498
South Africa | NA ftyo:"ara Technologies Pty | 586 0000 888
Unl.ted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LL.C
Israel NA Eastronics LTD 1-800-567000
: ; +84 8 38248007 Ho Chi Minh City
Vietnam NA EErTnS:r:VIﬁ d'"f°"“at'° +84 5113.562666 Danang City
e +84 5113.562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!stributor and/or service
provider currently
Distributor: Computer
880-2-9141747, 9127592
Bangladesh |NA i:)tl;rce Ltd (warranty buy- 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) 855-023-999992

(warranty buy-out)
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8. Khac phuc sw co &
Hoi Pap

8.1 Khac phuc sw cb

Trang nay giai quyét cac sw c6 von nguoi
dl:.lng c6 thé khic phuc. Néu sy cb van
tiép dién sau khi ban da thtr dung céac giai
phap trén trang nay, hay lién hé v&i dai
dién dich vu khach hang cta Philips.

H cac sw cé thwong gap

Khéng c6 hinh anh (Pén LED nguén

khéng sang) ) . .

+ Dam bao da cam day nguon vao 0
cam dién va mat sau ctia man hinh.

«  Trwéc tién, ddm bao nut ngudn &
mét tredc man hinh nam & vi tri OFF
(TAT), sau d6 ddy nat sang vi tri ON
(BAT).

Khéng c6 hinh anh (Bén LED ngu6n

sang trang)

*  Dam bdo da bat may tinh.

+ Dam bao cép tin hiéu da duwoc két nbi
dung cach véi may tinh cta ban.

*  Dam bdo cap man hinh khéng c6 cac
chau cdm bj cong trén mat két nbi.
Néu co, hay stra hay thay méi cap.

«  C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh thong bao

Attention

Check cable connection

+ Dam bao cap man hinh da duoc két
ndi dung cach véi may tinh cta ban.
(Ciing tham khao Hwéng dan khéi
dong nhanh).

+  Kiém tra xem cap man hinh c6 cac
chau cam bi cong hay khéng.

*  Dam bao da bat may tinh.
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Nut AUTO (Tw dong) khéng hoat dong

«  Chtc néng tw déng chi &p dung & ché
dd VGA- Analog. Néu khong hai long
véi két qua, ban co thé thue hién cac
didu chinh tht cdng qua menu OSD
(hién thi trén man hinh).

& Ghichu
Chtrc nang Auto (Tw dong) khdéng ap dung
& ché d6 DVI-KTS vi n6 khong can thiét.

Céac dau higu vé khoi hay tia Ira c6 thé

nhin thay

« Khéng thwe hién bat ky buéc khic
phuc sy ¢ nao

«  Ngét ngay két ndi man hinh khdi 6
cam dién chinh cho an toan

* Lién hé ngay vé&i dai dién dich vu
khach hang clia Philips.

B cac swc hinh anh

Hinh anh khéng nam giitra tim man

hinh

«  Chinh vj tri hinh anh qua chlrc nang
“Auto (Tw dong)” trong cac nut diéu
khién chinh trén menu OSD.

*  Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/Bdng hd) clia Setup (Cai
dat) trong cac nuat diéu khién chinh
trén menu OSD. N6 chi co6 hiéu lwc &
ché do VGA.

Hinh anh rung lén trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cam chét dung cach vao bang mach
dd hoa hay may tinh hay chua.

Hién thj hién twong chap chon doc

«  Chinh hinh anh qua ch&c nang “Auto
(Tw dong)” trong cac nat diéu khién
chinh cda menu OSD.



» Loai bé céac vach doc qua Phase/
Clock (Goc pha/Bdng hd) cliia Setup
(Cai dat) trong cac nuat diéu khién
chinh ctia menu OSD. N6 chi co6 hiéu
lwc & ché d6 VGA.

Hién thi hién twong chap chen ngang

* Chinh hinh anh qua chirc nang “Auto
(Tw doéng)” trong cac nut diéu khién
chinh ctia menu OSD.

» Loai bd céac vach doc qua Phase/
Clock (Goc pha/Bdng hd) cliia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co6 hiéu
lwe & ché dd VGA.

Hinh anh hién thi nhoe, khong ré hoac

qua mo

* Chinh d6 twong phan va do sang trén
menu Hién thi trén man hinh (OSD).

Hién twong “anh ao”, “anh thir nong”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

+ Hién thi lién tuc cac anh tinh trong mot
thoi gian dai co thé gay ra hién twong
“anh thir néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh a0”
hay “Anh béng ma” Ia hién twong phd
bién trong cong nghé man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh th&r nong” hoac “anh ao”
hay “anh bong ma” sé& dan dan bién
mat sau moét thdi gian man hinh bi
ngét dién.

e Ludn béat trinh bdo vé man hinh
chuyén ddng khi ban khéng st dung
man hinh.

e Lubn bat (rng dung lam m&i man hinh
dinh ky, néu khéng, man hinh LCD
cda ban sé hién thi nhirng ndi dung
tinh khong thay déi.

» Céac hién twong “anh thir néng” hay
“anh ao” hay “anh béng ma” sé khoéng
biét mat va ban cadn mang man hinh
di stra. Thiét hai nhw trén khong ndm
trong chinh sach bado hanh ctia chidng
toi.

Hinh hién thij bién dang. Van ban bi m¢

hoac nhoe.

« Cai do phan gidi man hinh may tinh
sang cung ché dd véi d6 phan giai
man hinh géc khuyén dung ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thj trén man hinh

« Céc cham con lai la d4c tinh théng
thworng cGia man hinh tinh thé 1éng
dung trong cdng nghé ngay nay. Vui
léng tham khao chinh sach diém anh
dé biét thém thong tin.

DPén “bat ngudn” qua sang va gay choi

maét

+  Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED ngudn trong cac nut
digu khién chinh ctia menu OSD.

Dé dwoc tro gitip thém, hay xem danh
sach Trung tdm thong tin khach hang
va lién hé va&i dai dién dich vu cham séc
khach hang cta Philips.



8.2 Héi bap chung

H1:

Khi cai cai dit man hinh, t6i can
l1am gi néu man hinh hién thj
“Cannot display this video mode”
(Khong thé hién thi ché dé video
nay)?

Dap: Do phan gidi khuyén dung cho man

hinh nay la: 1440 x 900 @60 Hz.
Ngat tAt ca cac cap roi két néi PC véi
man hinh ma ban da dung trwéc do.
Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang didu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co tén “desktop area (vung man hinh
nén)”, chuyén thanh trwot sang murc
1440 x 900 pixels.
Mé& thé “Advanced Properties” (Thudc
tinh nang cao) va cai Mc cap nhat
(Refresh Rate) sang 60Hz rdi click
OK.

Khéi dong lai may tinh va lap lai bwéc
2 va 3 dé kiém tra xem PC ctia ban da

dwoc cai sang mire 1440 x 900 @60
Hz hay chua.

T4t may tinh, ngat két ndi man hinh
cli va két néi lai man hinh LCD Philips
clia ban.

T&t man hinh rdi bat lai PC.

H2: Mdrc cap nhat khuyén dung cho

bap:

man hinh LCD la bao nhiéu?

Murc cap nhat khuyén dung cho man
hinh LCD la 60Hz. Néu c6 bt cwv
hién twong nhiéu nao trén man hinh,
ban c6 thé cai dat mrc ndy sang
75Hz @& kiém tra xem mirc mé&i nay
c6 loai bd dugc hién twong nhiéu
hay khoéng.
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H3:

bap:

H4:

bap:

H5:

bap:

He6:

bap:

H7:

bap:

Cac file .inf va .icm trén dia CD

1a gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Day la cac file driver cho man hinh
cla ban. Thuc hién theo cac chi dan
trong sb tay str dung dé cai d&t cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) hodc Iap dia driver khi ban
cai d&t man hinh 1an dau. Thyc hién
theo cac chi dan dé I&p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé&
dwoc cai dat ty dong.

Lam thé nao dé chinh do phan giai?
Card video/driver dd hoa cla ban

va man hinh sé& ciing quyét dinh

cac do phan giai c6 sén. Ban co thé
chon dd phan gidi mong mudn trong
Control Panel (Bang diéu khién)

clia Windows® qua thé “Display
properties” (Thudc tinh man hinh).
Diéu gi sé xay ra néu t6i quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nut OK rdi chon
“Reset” (Cai dét lai) d& phuc hdi moi
cai d&t mac dinh gbc.

Man hinh LCD c6 kha ning chéng
trdy xwérc?

N6i chung ban khéng nén dé& bé mat
man hinh va cham qua murc véi cac
vat khac hay va bao vé né khdi cac
vat dung sac hay cun. Khi cdm man
hinh, d@m bao khong dung strc ép
hay lwc manh 1&n phia b& mat man
hinh. Diéu nay cé thé anh hwéng
dén cac diéu kién bao hanh cda ban.

T6i nén lau man hinh LCD nhw thé
nao?

Dé lau thong thuong, hay sir dung
khan sach va mém. Dé lau ky, hay
duing cén isopropyl. Khéng dung
cac dung méi khac nhw con étylic,
ethanol, axeton, hexan, v.v...



H8: Toi co thé thay déi cai dat mau
séc cho man hinh?

Dap: DI nhién, ban cé thé thay dbi cai
dat mau sic qua nut didu khién trén
menu OSD theo cac quy trinh sau,

. Nhén “OK” dé hién thi menu OSD
(Hién thi trén man hinh)

. Nhan “Down Arrow” (Mi tén
xudng) dé chon tuy chon “Color”
(Mau) rdi nhan “OK” dé vao cai dat
mau; c6 ba lwa chon mau nhu sau.

1. Color Temperature (Nhiét d6 mau);
Hai cai dat gdm 6500K va 9300K.
V@i cac cai dat trong pham vi
6500K, man hinh sé hién thj “néng
véi tin hiéu mau dé-trang", trong khi
nhiét do 9300K tao ra “mat v&i tin
hiéu mau lam-tréng’.

2. sRGB (Pd-Luc-Lam chuén); day
la cai dat chudn dé& dam bao trao
ddi mau thich hgp gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon); ngwoi dung
c6 thé tw chon cai dat mau sac wu
tién bang cach chinh mau do, luc va
lam.

& Ghicha

Do mau anh sang téa ra tir mot vat dung

trong khi né dwoc lam néng. Sé do nay

dwoc thé hién dwa trén ty 18 tuyét déi, (mic
dé Kelvin). Cac mirc nhiét d6 Kevin thap
hon nhw 2004K la mau dé; cac mirc nhiét
dod cao hon nhw 9300K la mau lam. Nhiét
dé trung tinh 1a mau trdng & mirc 6504K.

H9: Téi c6 thé két n6éi man hinh LCD
vé&i moi PC, may cha hay may
Mac?

DPap: C6 thé. TAt ca cac man hinh LCD
Philips d&u hoan toan twong thich
v&i cac PC, may Mac va may ch
chuan. Ban c6 thé can cé dau noi
cap dé két néi man hinh mai hé
théng may Mac. Vui Idng lién hé voi
nhan vién kinh doanh cta Philips dé&
biét thém thong tin.

H10: Man hinh LCD Philips cé hé tro
chuén Plug-and-Play (Cadm vao la
phat)?

DPap: C6, cac man hinh Philips déu h tro
chuén Plug-and-Play twong thich
véi Windows 7/Vista/XP/NT, Mac
OSX, Linux

H11: Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

DPap: Hién thj lién tuc cac anh tinh trong
mot thdi gian dai cé thé gay ra hién
twong “anh thir néng”, con dwoc
goi la “anh ao” hay “anh bong ma”,
trén man hinh cta ban. “Anh tho
néng’, “Anh a0” hay “Anh béng ma”
I& hién twong phd bién trong cong
nghé man hinh LCD. Trong moi
trwdng hop, hién twong “anh thir
néng” hay “anh ao” hay “anh béng
ma” sé& bién mét dan trong mét thoi
gian sau khi d t&t nguén.

Ludn bat trinh bao vé man hinh
chuyé&n ddng khi ban khéng st
dung man hinh.

Ludn bat vng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD cla ban sé& hién thj nhirng noi
dung tinh khéng thay ddi.

O canh bao

Céac hién twgng “anh th&r nobng” hay “anh
40” hay “anh bong ma” sé& khong biét mat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng nam trong chinh sach
ba&o hanh cla chung toi.

H12: Tai sao man hinh cua téi hién thj
van ban sac nét va cac ky tw ring
cwa?

Pap: Man hinh LCD cua ban hoat déng
tot nhat & d6 phan giai gbc 1440 x
900 @ 60 Hz. P& man hinh hién
thi t&t nhét, vui Iong st dung do
phan giai nay.
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